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DM1000 Editor—Owner’s Manual

 

Special Notices

 

• The software and this owner’s manual are the exclu-
sive copyrights of Yamaha Corporation.

• Copying of the software or reproduction of this man-
ual in whole or in part by any means is expressly for-
bidden without the written consent of the 
manufacturer.

• Copying of the commercially available music 
sequence data and/or digital audio files is strictly pro-
hibited except for your personal use.

• Yamaha makes no representations or warranties with 
regard to the use of the software and documentation 
and cannot be held responsible for the results of the 
use of this manual and the software.

• This disc is a CD-ROM. Do not attempt to play the 
disc on an audio CD player. Doing so may result in 
irreparable damage to your audio CD player.

• The screen displays as illustrated in this owner’s man-
ual are for instructional purposes, and may appear 
somewhat different from the screens which appear on 
your computer.

• Future upgrades of application and system software 
and any changes in specifications and functions will 
be announced separately.

• The company names and product names in this 
Owner’s Manual are the trademarks or registered 
trademarks of their respective companies.

 

Yamaha Pro Audio Global Site

 

http://www.yamahaproaudio.com/
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* Specifications and descriptions in this owner ’s manual 
are for information purposes only. Yamaha Corp. 
reserves the right to change or modify products or 
specifications at any time without prior notice. Since 
specifications, equipment or options may not be the 
same in every locale, please check with your Yamaha 
dealer.
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DM1000 EditorDM1000 EditorDM1000 Editor
Owner’s Manual

 

Description of menus and buttons

 

In the event that menu and button names on a Windows system are different from those on a Macintosh, this manual 
uses the Windows menu and button names followed by the Macintosh menu and button names in parentheses.

http://www.yamahaproaudio.com/
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Getting Started

 

Overview of DM1000 Editor

 

DM1000 Editor enables you to remotely control the Yamaha DM1000 mixing console and to save 
the parameter settings on your computer. To use DM1000 Editor, you must first perform the fol-
lowing operations:

 

1

 

Start and configure Studio Manager.

 

2

 

Start and configure DM1000 Editor.

 

3

 

Synchronize DM1000 Editor with your DM1000 console (see page 4).

 

For more information on using Studio Manager, refer to the Studio Manager Owner’s Manual.

 

Configuring DM1000 Editor

 

You must configure the following settings for each open Editor.

 

❏

 

System Setup

 

To open the System Setup window, choose [System Setup] from the [File] menu. 

Be sure to specify the Input port and Output port.

 

Input port/Output port: 

 

From the ports you specified in Studio Manager, select the ports that 
the editor will use to communicate with the DM1000 console.

 

Console Device ID: 

 

DM1000 Editor can control any one of up to eight DM1000 consoles, each 
with its own exclusive ID. Select the ID of the console you want to control.

 

Note: 

 

• Specify MIDI ports in the Setup window of Studio Manager before making the following settings.
• To open each Editor, double-click the icon of the console or device you want to edit.
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Channel Select:  

 

These options determine whether or not channel selection is linked. When the 
PC->Console option is on, selecting a channel in DM1000 Editor selects the same channel on the 
console. When the Console->PC option is on, selecting a channel on the console selects the same 
channel in DM1000 Editor.

 

Confirmation: 

 

These options determine whether or not a confirmation dialog box appears 
when storing, recalling, or patching.

 

Layer Select:  

 

These options determine whether or not Layer selection is linked. When the 
PC->Console option is on, selecting a Layer in DM1000 Editor selects the same Layer on the con-
sole. When the Console->PC option is on, selecting a Layer on the console selects the same Layer 
in DM1000 Editor.

 

Window Control from Console: 

 

This option determines whether or not using the USER 
DEFINED KEYS on the console enables you to remotely open and close the DM1000 Editor win-
dows.

 

Level Meter: 

 

This option determines whether or not the level meters in DM1000 Editor are 
enabled.

 

❏

 

Console Setup

 

To open the Console Setup window, choose [Console Setup] from the [File] menu.

 

Surround Mode:  

 

Select a Surround mode from STEREO, 3-1, 5.1, and 6.1.

 

Pair Mode:  

 

These options determine whether the fader pair is Horizontal or Vertical.

 

Channel Copy Parameter:  

 

Select desired parameters to copy from channel to channel.
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Synchronizing DM1000 Editor

 

When DM1000 Editor starts up, the parameter settings on the console and the parameter settings 
in DM1000 Editor may be different. Therefore, you must first match the parameter settings on the 
console with those in DM1000 Editor. This operation is called “synchronization.” Follow the steps 
below to synchronize DM1000 Editor.

 

1

 

Select [Synchronize], then [Total 
Recall...].

 

The following window opens.

 

2

 

Select whether you want to transfer 
your settings to DM1000 Editor, or vice 
versa.

 

At this time, the All Libs option determines whether or not Scene and Library data is synchronized. 

 

PC -> Console: 

 

Transfers the current parameter settings in DM1000 Editor to your console.

 

Console -> PC: 

 

Transfers the current parameter settings of your console to the DM1000 Editor.

 

3

 

Click [OK].

 

Offline Edit Function

 

If you do not want to synchronize your console with DM1000 Editor, select [Offline Edit] from the 
[Synchronization] menu. To apply your off-line edits to your console, select [Re-Synchronize] 
from the [Synchronization] with the PC->Console option to synchronize the console with 
DM1000 Editor.

The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the 
Master window.

 

Working with Sessions

 

All of your console’s mix settings in DM1000 Editor, including Scene and library data, are called 
Sessions. The following table describes how to handle Sessions.

 

Do not operate the console while synchronization is in progress.

 

Note: 

 

If you use the “Total Recall” function in Studio Manager, all selected Editors in Studio Manager 
are synchronized with the corresponding devices.

 

Note: 

 

Some effect parameters in the console change their displayed values depending on the sampling 
frequency. If you switch DM1000 Editor from OFFLINE to ONLINE, displayed parameter values may 
change because DM1000 Editor loads the sampling frequency from the console and updates the dis-
play.

 

Creating a new Session Choose [New Session] from the [File] menu.

Opening a previously saved Session Choose [Open Session] from the [File] menu.

Saving the current Session Choose [Save Session] from the [File] menu.

Saving the current Session with a new name Choose [Save Session] As from the [File] menu.

 

Note: 

 

In order to save the current Automix, or the settings of an optional Y56K card, in a Session, 
you must first resynchronize DM1000 Editor by selecting the Console->PC option.
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If you save a Session in an Editor, only that Editor’s settings are saved in a file. The Editor’s settings 
are saved in either the Studio Manager V2 format (file extension “.YSE”) or a format that is com-
patible with earlier versions of Studio Manager (file extension “.D1X”). Note that earlier versions 
of Studio Manager cannot open a Session saved in the “.YSE” format.

If you save a Session in the Studio Manager window, all selected Editor settings are saved in a file 
with a file extension of “.YSM.”

 

Undo/Redo Function

 

In DM1000 Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of 
the latest operation (Redo). If you perform an Undo operation twice in a row, you can cancel the 
two most-recent operations. If you perform an Undo operation three times in a row, you can can-
cel the three most-recent operations. In this way, you can cancel multiple recent operations. The 
following table describes how to use the Undo/Redo function.

Please note, however, that after you perform one of the following operations, you cannot success-
fully undo or redo any previous operation:

• Operations on the console

• Closing Studio Manager

• Changing Surround mode (Stereo/3-1/5.1/6.1)

• Changing Pair mode (Horizontal/vertical)

• Synchronizing the console with DM1000 Editor

• Creating a new Session

• Saving a Session

• Copying and pasting a channel

• Creating or cancelling a channel pair

• Storing or recalling a scene or library

• Turning on or off the GATE: [LINK] button in the Selected Channel window

• Turning on or off the COMPRESSOR: [LINK] button in the Selected Channel window

• Turning on or off the [LINK] button in the Surround Editor window

• Changing Aux Send mode (Fixed/variable) on the console

• Starting automix recording or playback on the console

• Changing the sampling frequency (operated on the device)

• Changing the User Assignable Layer settings (operated on the device)

 

Undo Choose [Undo] from the [Edit] menu.

Redo Choose [Redo] from the [Edit] menu.

 

Note: 

 

You cannot Undo or Redo the following operations:
• Edits in the Setup window
• Synchronization
• Opening and closing the windows
• Resizing the windows

 

Note: 

 

In the Library window, you can Undo or Redo only the most recent operation. You cannot cancel 
the preceding operations.
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Other Functions

 

❏

 

Copy & Paste Function

 

You can copy and paste the channel parameters.

In the Console Setup window (page 3), you can also specify the parameters to be copied.

The following table describes how to use the Copy & Paste function.

 

❏

 

Resetting to the default value (Ctrl ( ) + click)

 

Move the cursor to a control or a parameter value, then hold down the <Ctrl> key ( ) and click 
the mouse button to reset the value to the default (e.g., to reset an Input Channel fader to –

 

∞

 

, or 
reset a pan setting to Center).

 

❏

 

Ctrl( )+Shift+Click

 

Move the cursor to a fader or AUX Send control, then hold down the <Ctrl> key ([ ]) and 
<Shift> key and click the mouse button to reset the value to the nominal level.

 

Copying a channel Right-click (<control>+click) a copy source channel, then choose [Copy].

Pasting a channel
Right-click (<control>+click) the copy destination channel, then choose 
[Paste].
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Using DM1000 Editor Windows

 

Master Window

 

The Master window enables you to switch between layers and control Stereo Out sig-
nals. To open this window, choose [Master] from the [Windows] menu.

 

A

 

[ONLINE]/[OFFLINE] button

 

Repeatedly clicking this button toggles between online and offline status.

 

This indicator is displayed when DM1000 Editor is connected to the 
DM1000 correctly. If the connection is correct, the DM1000 Editor 
parameters will work in unison with the DM1000 parameters.

This indicator is displayed when DM1000 Editor is not connected or 
is not communicating with the DM1000, or when you have selected 
Offline Edit. If the connection is incomplete, the DM1000 Editor 
parameters will not work in unison with the DM1000 parameters.

 

B

 

Meters

 

These meters display the output level of the 
Stereo Out when Surround mode is set to 
“STEREO,” or the Bus Outs used for sur-
round processing when Surround mode is 
set to 3-1, 5.1 or 6.1. The meters in 3-1, 5.1 
and 6.1 Surround modes are shown on the 
right.

 

C

 

LAYER buttons

 

These buttons are used to select the Layers.

 

D

 

PAN CONTROL

 

These buttons are used to select either 
“STEREO” (Stereo display mode) or 
“SURR” (Surround display mode). The 
Pan control on the Input Channels is a rotary control when “STEREO” is 
selected, and a dot on a pan graph when “SURR” is selected. If Surround mode is 
set to Stereo, the [SURR] button will be disabled.

 

E

 

Scene number display

 

This display indicates the currently-recalled scene’s number.

 

F

 

[AUTO] button

 

This button displays the Automix status of the Stereo Out.

 

G

 

[SELECT] button

 

This button is used to select the Stereo Out.

 

H

 

[ON] button

 

This button turns the Stereo Out on and off. It appears orange while the Stereo 
Out is on.

 

I

 

Master fader

 

This is the Stereo Out fader.

 

J

 

Fader value indicator

 

This indicator indicates the fader position in decibels (dB).

 

Note: If DM1000 Editor is not connected or is not communicating with the 
DM1000, clicking this button will not switch the unit from offline to online.

2

1

3

4

5

6
7

8

9

J

3-1 5.1 6.1
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Layer Windows

 

The Layer window displays 16 channel strips. You can select a layer using the LAYER buttons in the 
Master window. To open the Layer window, choose [Layer] from the [Windows] menu.

 

❏

 

Input Channels

 

Selecting the 1-16, 17-32, or 33-48 button in the Master window displays the corre-
sponding Input Channel strips.

 

A

 

SOURCE parameter

 

This parameter is used to select an Input source. To select an Input source, click the 
parameter and choose from the list that appears.

 

B

 

Routing buttons

 

These buttons are used to route the Input Channel to the Bus Outs.

 

C

 

[STEREO] button

 

This button is used to route the Input Channel’s signal to the Stereo Out.

 

D

 

[DIRECT] button

 

This button turns on and off the Input Channel’s routing to its Direct Out.

 

E

 

Direct Out parameter

 

This parameter is used to select the Direct Out destination. To select a destination, 
click the parameter and choose from the list that appears.

 

F

 

[PHASE] button

 

This button is used to reverse the signal phase of the channel.

 

G

 

[INSERT] button

 

This button is used to turn on and off the Input Channel’s Insert.

 

H

 

[GATE] button

 

This button is used to turn on and off the Input Channel’s Gate.

 

I

 

Gate open/close indicators

 

These indicators display whether the Gate is open (green) or closed (red).

 

J

 

Gate threshold

 

This displays the Gate Threshold, which can be set by dragging.

 

K

 

[COMP] button

 

This button is used to turn on and off the Input Channel’s Compressor.

 

L

 

Compressor curve

 

This display shows the Compressor’s curve.

 

M

 

[EQ] button

 

This button is used to turn on and off the Input Channel’s EQ.

 

N

 

EQ curve

 

This display shows the Equalizer’s curve, which can be set by dragging.

 

O

 

[DELAY] button

 

This button is used to turn on and off the Input Channel’s Delay function.

 

Note: 

 

• You can selectively turn on or off some of channel strips by using the [View] menu.
• You can open multiple Layer windows by choosing [Windows] menu -> [Layer] -> [Additional View]. 

The titles of these windows will indicate [Locked]. Windows that are indicated as [Locked] will not 
reflect layer changes made on the console or in the Master window. If you want the Layer windows to 
reflect the changes, right-click each window (Macintosh: <control> + click), then select the desired layer 
using the LAYER buttons.

A

B

C
D
E

F
G

H
I

J
K

L

M

N

O
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PDelay parameter
This parameter is used to set the delay time of the Delay function. Delay times can be 
set by dragging.

Q Channel number
This is the channel number. Double-click the channel number to open the Selected 
Channel window.

R AUX section
These controls are used to set the levels of the Aux Sends. To set an Aux 
Send level, drag its bar or click a point along the length of the bar. To turn 
an Aux Send on or off, click its number.

The following table shows how the Aux Send controls appear depending 
on the Aux Send On/Off and Pre/Post settings. Aux Sends can be set to 
pre-fader or post-fader on the Selected Channel window (see “AUX 
SEND section” on page 13).

S Pan/Aux Send display
This display shows the stereo or surround pan position or, while setting an Aux Send, 
the Aux Send level in dB.

T PAN control
This control is used to set the Input Channel’s stereo or surround pan position. 
When the PAN CONTROL in the Master Window is set to “STEREO,” the Pan con-
trol appears as a rotary control, and when set to “SURR,” the control appears as dot 
on a pan graph. The surround pan position can be set by dragging the dot. 

U LFE control
When 5.1 or 6.1 Surround mode is selected, this control is used to set the 
surround LFE Channel level. It appears when the PAN CONTROL in the 
Master Window is set to “SURR.” To set the Channel level, drag the end of 
its bar or click a point along the length of the bar.

V [AUTO] button
This button displays the Automix status of the Input Channel.

W [SELECT] button
This button is used to select the Input Channel.

X [SOLO] button
This button solos the Input Channel. It appears orange while the channel is soloed.

Y [ON] button
This button turns the Input Channel on and off. It appears orange while the channel 
is on.

Z Short channel name
This is the channel’s short name. To edit the name, click it and type.

a Channel fader and channel meter
This is the Input Channel fader. The channel meter to the right of the fader displays 
the Input Channel signal level.

b Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).

P
Q

R

S

T

V
W
X

Y
Z

a

b

Aux Send status Appearance

On or off but no level set Dark blue bar

Off, pre-fader Green bar outline displays level

On, pre-fader Green bar displays level

Off, post-fader Orange bar outline displays level

On, post-fader Orange bar displays level

U
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❏ Output Channels
When you select the Master LAYER button in the Master window, the Bus Out and 
Aux Send channels are displayed. The Aux Send channel appears the same as the Bus 
Out channels except that the Bus Out channels feature a [STEREO] button.

A [STEREO] button (Bus Out only)
This button is used to route the Bus Out to the Stereo Out.

B [INSERT] button
This button is used to turn on and off the Bus Out’s Insert.

C [COMP] button
This button is used to turn on and off the Bus Out’s Compressor.

D Compressor curve
This display shows the Compressor’s curve.

E [EQ] button
This button is used to turn on and off the Bus Out’s EQ.

F EQ curve
This display shows the Equalizer’s curve, which can be set by dragging.

G [DELAY] button
This button is used to turn on and off the Bus Out’s Delay function.

HDelay parameter
This parameter is used to set the delay time of the Delay function. Delay times 
can be set by dragging.

I Channel number
This is the channel number. Double-click the channel number to open the 
Selected Channel window.

J [AUTO] button
This button displays the Automix status of the Bus Out.

K [SELECT] button
This button is used to select the Bus Out.

L [SOLO] button
This button solos the Bus Out. It appears orange while the Bus Out is soloed.

M [ON] button
This button turns the Bus Out on and off. It appears orange while the Bus Out is 
on.

N Short channel name
This is the channel’s short name. To edit the name, click it and type.

O Channel fader and channel meter
This is the Bus Out fader. The meter to the right of the fader displays the Bus Out 
signal level.

P Fader value indicator
The fader value indicator indicates the fader position in decibels (dB).

G
H

A

B

C

D

E

I

J

L

N

P

O

F

K

M
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❏ Remote Channels
When you select the REMOTE 1 or REMOTE 2 LAYER button in the Master win-
dow, Remote Channels are displayed.

A Channel number
This is the channel number. Double-click the channel number to open the 
Selected Channel window.

B [SELECT] button
This button is used to select the Remote Channel.

C [ON] button
This button turns the Remote Channel on and off. It appears orange while the 
channel is on.

D Remote target name
This name indicates the remote target assigned on the DM1000.

E Channel fader
This is the Bus Out’s fader. 

F Fader value indicator
This indicator indicates the fader position in the range of 0 through 127.

If the remote target is set to User Assignable Layer:
In this case, the assigned channels are displayed. For more information, refer to 
“Input Channels” on page 8 and “Output Channels” on page 10. If the Group Master 
Fader is assigned, only the [AUTO], [SOLO], and [ON] buttons and channel faders 
are displayed.

Note: When the remote target setting on the DM1000 is set to User Defined, you 
can use the [ON] buttons and channel faders to control the functions specified on 
the Remote page.

Note: When the remote target setting on the DM1000 is set to User Defined, you 
can use the [ON] buttons and channel faders to control the functions specified on 
the Remote page.

A

B

C
D

F

E



U
si

ng
 D

M
10

00
 E

di
to

r 
W

in
do

w
s

 

G
et

ti
n

g
 S

ta
rt

ed

 

K
ey

bo
ar

d 
S

ho
rt

cu
ts

 

In
d

ex

 

12

 

DM1000 Editor—Owner’s Manual

 

 W
in

do
w

s

 

Selected Channel Window

 

The Selected Channel window allows detailed editing of the currently selected channel. To open the 
Selected Channel window, choose [Selected Channel] from the [Windows] menu.

There are four variations of the layout of the Selected Channel window, as follows:

• Input Channels (see below)

• Bus Outs (see page 14)

• Aux Sends (see page 15)

• Stereo Outs (see page 16)

 

❏

 

Input Channels

 

A

 

CHANNEL SELECT, INPUT PATCH & LIBRARY section

 

Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type. The INPUT PATCH parameter is used to select an input 
source. To select an input, click the parameter and choose from the list that appears. The [LIBRARY] 
button opens the Channel Library window.

 

B

 

GATE section

 

This section contains the Gate controls and display graph for the currently selected Input Channel. 
The rotary controls are used to set the threshold, range, attack, decay, and hold. The GR meter indi-
cates the amount of gain reduction being applied by the Gate. The OUT meter indicates its output 
level. The [ON] button turns the Gate on and off. The [LINK] button links the Gate of the currently 
selected Input Channel with the Gate of its partner channel. The KEY IN parameter is used to select a 
Gate trigger source. The [LIBRARY] button opens the Gate Library window.

 

Note: 

 

You can open multiple Selected Channel windows by choosing [Windows] menu -> 
[Selected Channel] -> [Additional View]. The titles of these windows will indicate 
[Locked]. You cannot open Library windows from windows that are indicated as [Locked]. 
In addition, these windows will not reflect the following operations:
• Channel selections made in the Layer window (via the SELECT button)
• Edits in the Surround Editor window

A B DC E F

G H I
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C EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Input Channel. The 
rotary controls are used to set the gain, center frequency, and Q of each band, and the pre-EQ attenuation 
level. EQ can also be set by dragging the EQ curve on the EQUALIZER graph. The [ON] button turns the 
EQ on and off. The TYPE buttons select the EQ type. The [LIBRARY] button opens the Equalizer Library 
window.

DDELAY & PHASE section
This section contains the delay and phase controls for the currently selected Input Channel. The rotary 
controls are used to set the delay time, feedback gain, and mix balance (wet/dry balance). The [ON] 
button turns the Delay on and off. The [PHASE] button reverses the channel’s signal phase.

E ROUTING, PAN & level section
This section contains the routing, pan, and level controls and the [AUTO], [SOLO], and [ON] buttons 
for the currently selected Input Channel. ROUTING buttons 1–8 are used to route the channel to the 
Bus Outs. The [STEREO] button routes the channel to the Stereo Out. The [DIRECT] button routes 
the channel to its Direct Out, and the Direct Out parameter below it selects a Direct Out destination. 
The [F.PAN] button turns on and off the Bus Out Follow Pan function. The PAN control is used to 
pan the channel. The [AUTO] button displays the Automix status. The [SOLO] button is used to solo 
the channel, the [ON] button, to turn on and off the channel, and the channel fader, to set the channel 
level. The meter to the right of the fader indicates the signal level, and the value indicator under the 
fader indicates the fader position in decibels (dB).

F AUX SEND section
This section contains the Aux Send controls for the currently selected Input Channel. Use the rotary 
controls to set the Aux Send levels, and click them to turn Aux Sends on and off. Use the button below 
each Aux Send control to select pre-fader or post-fader. In Fixed mode, this button is used to turn Aux 
Sends on and off (the level is fixed at nominal).

When Aux Sends are paired, a heart icon is displayed between them, and the odd-numbered Aux Send 
control sets the level, while the even-numbered control works as a pan control.

G INSERT section
This section contains the Insert parameters for the currently selected Input Channel. The [ON] button 
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination 
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert 
in the signal path.

H COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Input 
Channel. The rotary controls are used to set the threshold, ratio, attack, release, gain, and knee. The 
GR meter indicates the amount of gain reduction being applied by the Compressor. The OUT meter 
indicates its output level. The [ON] button turns the Compressor on and off. The [LINK] button links 
the Compressor of the currently selected Input Channel with the Compressor of its partner channel. 
The POSITION parameter is used to specify the position of the Compressor in the signal path. The 
ORDER parameter is used to specify the order of the Compressor and Insert when both are inserted 
at the same position. The [LIBRARY] button opens the Compressor Library window.

I PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Input Channel. Click the heart icon to pair and unpair the channel with its partner chan-
nel. Use the FADER GROUP buttons to add the channel to Fader groups, and use the 
MUTE GROUP buttons to add it to Mute groups.
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❏ Bus Outs

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Bus Out. It’s layout 
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 13 for 
more information.

CDELAY section
This section contains the delay controls for the currently selected Bus Out. The rotary control is used 
to set the delay time, and the [ON] button turns the Delay function on and off.

D TO STEREO & level section
This section contains the TO STEREO, pan and level controls and the [AUTO], [SOLO], and [ON] but-
tons for the currently selected Bus Out. The TO STEREO button routes the Bus Out to the Stereo Out, 
and the rotary controls are used to set the Bus to Stereo send level and pan. The [AUTO] button displays 
the Automix status. The [SOLO] button is used to solo the Bus Out, the [ON] button, to turn the Bus 
Out on and off, and the channel fader, to set the Bus Out level. The meter to the right of the fader indi-
cates the signal level, and the value indicator under the fader indicates the fader position in dB.

E INSERT section
This section contains the Insert parameters for the currently selected Bus Out. The [ON] button turns 
the Insert on and off. The OUT and IN parameters are used to select the insert out destination and 
insert in source respectively. The POSITION parameter is used to specify the position of the Insert in 
the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Bus Out. 
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section” 
on page 13 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Bus Out. Click the heart icon to pair and unpair the channel with its partner channel. Use 
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE 
GROUP buttons to add it to Mute groups.

A CB D

E F G
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❏ Aux Sends

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the currently selected Aux Send. It’s layout 
is identical to the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 13 for 
more information.

CDELAY section
This section contains the delay controls for the currently selected Aux Send. The rotary control is used 
to set the delay time, and the [ON] button turns the Delay function on and off.

D Aux Send level section
This section contains the [AUTO], [SOLO], and [ON] buttons and the channel fader for the currently 
selected Aux Send. The meter to the right of the fader indicates the signal level, and the value indicator 
under the fader indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the currently selected Aux Send. The [ON] button 
turns the Insert on and off. The OUT and IN parameters are used to specify the insert out destination 
and insert in source respectively. The POSITION parameter is used to specify the position of the Insert 
in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Aux Send. 
Its layout is identical to the COMPRESSOR section for Input Channels. See “COMPRESSOR section” 
on page 13 for more information.

G PAIR, FADER GROUP & MUTE GROUP section
This section contains the Pair, Fader and Mute group functions for the currently selected 
Aux Send. Click the heart icon to pair and unpair the channel with its partner channel. Use 
the FADER GROUP buttons to add the channel to Fader groups, and use the MUTE 
GROUP buttons to add it to Mute groups.

A CB D

E F G
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❏ Stereo Out

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and choosing from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. The [LIBRARY] button opens the Channel Library window.

B EQUALIZER section
This section contains the EQ controls and display graph for the Stereo Out. It’s layout is identical to 
the EQUALIZER section for Input Channels. See “EQUALIZER section” on page 13 for more infor-
mation.

CDELAY section
This section contains the delay controls for the Stereo Out. The rotary control is used to set the delay 
time, and the [ON] button turns the Delay function on and off.

D Balance & level section
This section contains the balance control, [AUTO] and [ON], and channel fader for the Stereo Out. 
The meter to the right of the fader indicates the signal level, and the value indicator under the fader 
indicates the fader position in decibels (dB).

E INSERT section
This section contains the Insert parameters for the Stereo Out. The [ON] button turns the Insert on 
and off. The OUT and IN parameters are used to specify the insert out destination and insert in source 
respectively. The POSITION parameter is used to specify the position of the Insert in the signal path.

F COMPRESSOR section
This section contains the Compressor controls and display graph for the currently selected Stereo Out. 
Its layout is identical to the COMPRESSOR section for Input Channels except there is no [LINK] but-
ton. See “COMPRESSOR section” on page 13 for more information.

G FADER GROUP & MUTE GROUP section
This section contains the Fader and Mute group functions for the Stereo Out. Use the FADER GROUP 
buttons to add the Stereo Out to Fader groups, and use the MUTE GROUP buttons to add it to Mute 
groups.

A CB D

E F G
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Library Window
The Library window enables you to control and manage Scenes and libraries. In addition, Scenes and 
libraries can be saved to disk on your computer as Library files.

To open the Library window, choose [Library] from the [Windows] menu. The Library window con-
sists of 9 display pages. You can access each of these pages by clicking the tabs along the top of the win-
dow, or by following the action described below:

The layout of the Library window pages is the same regardless of which page is selected (the Scene 
Memory library is shown below). The Library window consists of two panes. The pane on the left, 
called the [FILE] section, displays the status of the currently open library file. The pane on the right, 
called the [INTERNAL DATA] section, displays the status of the corresponding library in the console.

You can copy and sort the items in the list (memories) by dragging them between the panes. Within 
the same pane, you can copy a memory by dropping it on top of another memory, and you can sort 
memories by dropping a memory between two memories. Memory contents can be swapped by hold-
ing down the <Shift> key while dragging. In all cases, the contents of the destination memory are 
overwritten. To edit a memory title, click the title, then type.

A File name
This is the file name of the currently open Library file.

B [OPEN] button
This button is used to open Library files.

Library page Action

Channel Library

[LIBRARY] buttons on the Selected Channel window
Gate Library

Compressor Library

Equalizer Library

Input Patch Library
[LIBRARY] button on the Patch Editor window

Output Patch Library

Effect Library [LIBRARY] buttons on the Effect Editor window

Note: DM1000 Editor may be unable to open some files stored in SmartMedia. In this case, copy those 
files onto a hard disk, then try to open them in DM1000 Editor.

A

F
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C [CLOSE] button
This button is used to close the currently open Library file.

D [SAVE] button
This button is used to save the currently open Library file.

E [SAVE AS] button
This button is used to save the currently open Library file with a different name.

F TITLE
This column displays the memory titles.

G PROTECT (only for Scene memories and Automix memories)
This column displays padlock icons for protected memories. It also displays an “ ” (read-only) icon 
for preset data.

H INPUT PATCH LINK (only for Scene memories)
This column displays the input patch memory numbers linked to the Scene library. When you store 
or recall a Scene memory, the linked Input Patch Library memory is stored or recalled at the same 
time.

IOUTPUT PATCH LINK (only for Scene memories)
This column displays the Output Patch memory numbers linked to the Scene library. When you store 
or recall a Scene memory, the linked Output Patch Library memory is stored or recalled at the same 
time.

J [STORE] button
This button is used to store the contents of the library to the specified location.

K [RECALL] button
This button is used to recall the selected memory.

L [FILE] section
This section displays the contents of the currently open library file.

M [INTERNAL DATA] section
This section displays the console’s status of the currently selected library.

N [CLEAR] button
This button clears the selected memory from the list.

O [UNDO] button
This button undoes the last recall, store, copy, clear, sort or titling operation.

P [PROTECT] button (only for Scene memories and Automix memories)
This button is used to protect or unprotect the selected memory.

Note: You cannot store Automix memories during offline editing.

Note: In the Effect Library page, the number of the internal effect processor to which the store/recall oper-
ation applies is shown above the [STORE] button.

Note: You cannot recall Automix memories during offline editing.

Note: If the OFFLINE indicator is selected by the [ONLINE]/[OFFLINE] button in the Master window, 
DM1000 Editor is not synchronizing with the console. Therefore, this section does not display the console’s 
correct status.

Note: In the Library window, you can undo only the most recent operation. You cannot undo any oper-
ations performed prior to the most recent operation.
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Patch Editor Window
The Patch Editor window is used to patch Inputs, Outputs, Inserts, Effects, and Direct Outs. To open 
this window, choose [Patch Editor] from the [Windows] menu. This window consists of five pages, 
which you can select by clicking the tabs along the top of the window.

❏ INPUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Input Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay is used to patch input ports to Input Channels. Active patches are indicated by a blue 
dot. To make a patch, click a square. To unpatch, click a blue dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

Note: Input sources (AD1–AUX8) that are assigned to a cascade connection (CAS BUS1–CASSOLOR) 
cannot be assigned to non-cascade-connected channels (CH1–48).

BA C D E

G
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❏ OUTPUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [AUTO SETUP] button
Clicking this button sets the patches on this page to their initial values.

D [ALL CLEAR] button
This button clears all patches on this page.

E [LIBRARY] button
This button opens the Output Patch Library window.

F Port names
These are the Port names. To edit a name, click it and type.

G Patchbay
The patchbay enables you to patch output ports to Output Channels. Active patches are indicated by 
a red dot. To make a patch, click a square. To unpatch, click a red dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

BA C D E

G
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❏ INSERT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] buttons
These buttons open the Input and Output Patch Library windows.

D Port names
These are the Port names. To edit a name, click it and type.

E Insert Out Patchbay
This patchbay is used to patch output ports to the Insert Outs of Input Channels, Bus Outs, Aux Sends, 
and the Stereo Out. Active patches are indicated by a red dot. To make a patch, click a square. To 
unpatch, click a red dot.

F Insert In Patchbay
This patchbay is used to patch input ports to the Insert Ins of Input Channels, Bus Outs, Aux Sends, 
and the Stereo Out. Active patches are indicated by a blue dot. To make a patch, click a square. To 
unpatch, click a blue dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

B C

E F

D
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❏ EFFECT PATCH Page

A Effects processor 1 section
This section indicates the effects name assigned to internal Effects processor 1. The parameters in this 
section are used to select inputs and outputs for Effects processor 1.

B [LIBRARY] button
This button opens the Input Patch Library window.

C Effects processors 2–4 section
This section indicates the effects names assigned to internal Effects processors 2–4. The parameters in 
this section are used to select inputs and outputs for Effects processors 2–4.

A B

C
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❏ DIRECT OUT PATCH Page

A Channel IDs
These are the Channel IDs.

B Long channel names
These are the Channel long names. To edit a name, click it and type.

C [LIBRARY] button
This button opens the Output Patch Library window.

D Port names
These are the Port names. To edit a name, click it and type.

E Patchbay
The patchbay is used to patch output ports to the Direct Outs. Active patches are indicated by a red 
dot. To make a patch, click a square. To unpatch, click a red dot.

Note: You can also use the cursor keys and the <ENTER> key on the computer keyboard to make a patch.

BA C

E
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Surround Editor Window
The Surround Editor window enables you to edit the surround pan position of the currently selected 
Input Channel. To open the Surround Editor window, choose [Surround Editor] from the [Win-
dows]menu.

A CHANNEL SELECT section
Channels can be selected by clicking the Channel ID and selecting from the list that appears, or by 
clicking the left and right Channel Select buttons. The long channel name is displayed below the Chan-
nel ID. To edit the name, click it and type.

B Surround pan graph
The green dot on this graph indicates the surround pan position for the currently selected Input Chan-
nel. The surround pan can be set by dragging the dot. Clicking a speaker icon will move the pan posi-
tion to the position of that icon.

C Surround pan position
This is the current surround pan position.

D SURROUND MODE parameter
Click this parameter to display the option list and set Surround mode to STEREO, 3-1, 5.1, or 6.1.

E [LFE] control
This rotary control sets the level of the LFE channel.

F [DIV.F] control (6.1)/[DIV] control (3-1, 5.1)
This rotary control sets the amount of divergence (i.e., how the Center signal is fed to the Left, Right, 
and Center channels). With 6.1 surround, you can set the divergence for both the front and rear. The 
[DIV.F] control sets the amount of divergence for the front signal.

G [DIV.R] control (6.1 only)
This rotary control sets the amount of divergence for the rear signal.

H [LINK] button (6.1 only)
This button is used to link the [DIV.F] and [DIV.R] controls.

A

D

B

C

E

F

G
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Timecode Counter Window
The Timecode Counter window displays the current timecode position in hours, minutes, seconds, 
and frames — or measures, beats, and MIDI clocks — depending on the specified timecode source. It 
works in unison with the timecode counters on the DM1000 Automix Main page. If the frame rate is 
drop frame, a “.” is displayed following the frame number.

To open the Timecode Counter window, choose [Timecode Counter] from the [Windows] menu.

Effect Editor Window
The Effect Editor window enables you to edit the internal effects processors. To open the Effect Editor 
window, choose [Effect Editor] from the [Windows] menu.

A Effects processor select
These buttons are used to select the internal effects processors.

B Effect select section
The EFFECT NAME, TYPE, and IN/OUT are the name, type and I/O configuration of the effect 
recalled to the currently selected effects processor. To edit the EFFECT NAME, click it and type. The 
[LIBRARY] button opens the Effects Library window.

C [IN] button
This button is used to set the metering position to the effects processor’s inputs.

D [OUT] button
This button is used to set the metering position to the effects processor’s outputs.

Note: You can open multiple Effect Editor windows by choosing [Windows] menu -> [Effect Editor] and 
making a choice other than [Generic Editor]. The titles of these windows will indicate [Locked]. You can-
not open Library windows from windows that are indicated as [Locked].
When you recall effects, windows that do not indicate “Locked” in the title will be recalled.

    hour            minute         second          frame                           measure                  beat        MIDI clock

A B 53 4

F G H
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EMeters
These are input or output meters for the currently selected effects processor.

F Effect parameter section
This section contains the various effects controls, buttons, and displays. Its layout depends on the 
selected effect type.

G [MIX BALANCE] control
This control enables you to adjust the balance between the wet and dry signals. When set to 0, only the 
dry signal is heard. When set to 100, only the wet signal is heard.

H [BYPASS] button
This button is used to bypass the currently selected effects processor.

I PLAY/REC section
This is shown only if the selected effect type is FREEZE. To start record-
ing (sampling), click the [REC] button and then click the [PLAY] but-
ton. The progress bar shows the current recording location. To play 
back the recorded sample, click the [PLAY] button.

J TEMPO section
This is shown only if the selected effect type includes a TEMPO param-
eter. You can turn the rotary knob to set the TEMPO parameter 
directly. If you turn on the [MIDI CLK] button, the tempo will syn-
chronize with MIDI Clock messages from an external device. If you 
repeatedly click the [TAP TEMPO] button, the TEMPO parameter will 
be set to the corresponding interval.

K SOLO section
This is shown only if the selected effect type is M.BAND DYNA. Only 
the bands that are turned on will be output. If all bands are turned on 
or off, all bands will be output.



U
si

ng
 D

M
10

00
 E

di
to

r 
W

in
do

w
s

G
et

ti
n

g
 S

ta
rt

ed
K

ey
bo

ar
d 

S
ho

rt
cu

ts
In

d
ex

27DM1000 Editor—Owner’s Manual

 W
in

do
w

s

Meter Window
The Meter window displays the Input, Output, Effect, and Stereo Out meters. To open the Meter win-
dow, choose [Meter] from the [Windows] menu. This window consists of four display pages. You can 
access these pages by clicking the tabs along the top of the window.

The layout of the Meter window pages is the same regardless of the page selected. (The Master page is 
shown below.)

AMeter mode
You can select the type of meters to be displayed from the following options:

GATE GR: The meters indicate the amount of gain reduction being applied by the channel Gate.

COMP GR: The meters indicate the amount of gain reduction being applied by the channel 
Compressor.

LEVEL: The meters indicate the channel level.

B POSITION parameter
This parameter, available only when Meter mode is set to Level, enables you to select the metering 
position in the signal path.

C PEAK HOLD button
This button turns the Peak Hold function on and off.

Page Function

CH1-48 page This page displays the Input Channel CH1-48 meters (12 segments).

MASTER page This page displays the Bus 1-8, Aux 1-8, and Stereo meters (12 segments).

Effects 1-4 page
This page displays the Channel 1 & 2 input/output meters (12 segments) for Effects 
1-4.

Stereo page This page displays a bar graph (32 segments) of signal levels output to the Stereo Out.

A 2 3



U
si

ng
 D

M
10

00
 E

di
to

r 
W

in
do

w
s

G
et

ti
n

g
 S

ta
rt

ed
K

ey
bo

ar
d 

S
ho

rt
cu

ts
In

d
ex

28DM1000 Editor—Owner’s Manual

 W
in

do
w

s

Keyboard Shortcuts

Menu Action Windows Macintosh

File menu

Creates a new Session Ctrl+N +N

Opens a previously saved Session Ctrl+O +O

Saves the current Session Ctrl+S +S

Edit menu
Undo Ctrl+Z +Z

Redo Ctrl+Y +Y

Windows menu

Closes the active window Ctrl+W +W

Closes all windows Ctrl+Alt+W +Option+W

Opens the Master window Ctrl+1 +1

Opens the Layer window Ctrl+2 +2

Opens the Selected Channel window Ctrl+3 +3

Opens the Library window Ctrl+4 +4

Opens the Patch Editor window Ctrl+5 +5

Opens the Surround Editor window Ctrl+6 +6

Opens the Timecode Counter window Ctrl+7 +7

Opens the Effect Editor window Ctrl+8 +8

Opens the Meter window Ctrl+9 +9

Library window

Selects consecutive multiple items (memories) Shift+click shift+click

Selects non-consecutive multiple items (memories) Ctrl+click +click

Selects all memories in a section Ctrl+A +A
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Index

Numerics
1-16 button ...................................... 7
17-32 button .................................... 7
33-48 button .................................... 7

A
ALL CLEAR button ................ 19, 20
AUTO button ........................ 7, 9, 10
AUTO SETUP button ............ 19, 20
Aux Section ...................................... 9
Aux Send level section .................. 15
AUX SEND section ....................... 13
Aux Sends ...................................... 15

B
Balance & level section .................. 16
Bus Outs ......................................... 14
BYPASS button ............................. 26

C
CH1-48 page .................................. 27
Channel Copy Parameter ............... 3
Channel fader ...................... 9, 10, 11
Channel IDs ................. 19, 20, 21, 23
Channel Library ............................ 17
channel meter ............................ 9, 10
Channel number ................. 9, 10, 11
Channel Select ................................. 3
CHANNEL SELECT section

.................. 12, 14, 15, 16, 24
CLEAR button ............................... 18
CLOSE button ............................... 18
COMP button ........................... 8, 10
Compressor curve ..................... 8, 10
Compressor Library ...................... 17
COMPRESSOR section

........................ 13, 14, 15, 16
Configuring the Editor ................... 2
Confirmation ................................... 3
Console -> PC ............................. 3, 4
Console Device ID .......................... 2
Console Setup .................................. 3
Copy ................................................. 6
Creating a new Session ................... 4
Ctrl + click ....................................... 6
Ctrl + Shift + Click .......................... 6

D
DELAY & PHASE section ............ 13
DELAY button ........................... 8, 10

Delay parameter .........................9, 10
DELAY section ...................14, 15, 16
DIRECT button .............................. 8
Direct Out parameter ..................... 8
Direct out patch page ................... 23
DIV.F control/DIV control .......... 24
DIV.R control (6.1 only) .............. 24
dry signal ....................................... 26

E
Effect editor window .................... 25
Effect Library ................................. 17
EFFECT NAME ............................ 25
Effect parameter section ............... 26
Effect patch page ........................... 22
EFFECT TYPE .............................. 25
Effects 1-4 page ............................. 27
Effects processor 1 section ........... 22
Effects processor select ................. 25
Effects processors 2-4 section ...... 22
EQ button ...................................8, 10
EQ curve .....................................8, 10
Equalizer Library .......................... 17
EQUALIZER section ...13, 14, 15, 16

F
FADER GROUP buttons

.........................13, 14, 15, 16
FADER GROUP section

.........................13, 14, 15, 16
Fader value indicator .......7, 9, 10, 11
File name ....................................... 17
FILE section ................................... 18

G
GATE button .................................. 8
Gate Library .................................. 17
Gate open/close indicators ............. 8
GATE section ................................ 12
Gate threshold ................................. 8
Group Master Fader ..................... 11

I
IN button ....................................... 25
Index .............................................. 29
Input Channels ..........................8, 12
Input Patch Library ...................... 17
INPUT PATCH LINK .................. 18
Input patch page ........................... 19
INPUT PATCH section ............... 12
Input Port/Output Port ................. 2

INSERT button ..........................8, 10
Insert In Patchbay .........................21
Insert Out Patchbay ......................21
Insert patch page ...........................21
INSERT section ........... 13, 14, 15, 16
INTERNAL DATA section ...........18

K
Keyboard shortcuts .......................28

L
LAYER button ..................... 7, 10, 11
Layer Select ......................................3
Layer Windows ................................8
Level Meter ......................................3
level section ....................................13
LFE control ................................9, 24
Library

Channel ....................................17
Compressor ..............................17
Effect .........................................17
Equalizer ...................................17
Gate ...........................................17
Input Patch ..............................17
Output Patch ...........................17

LIBRARY button
............ 14, 19, 20, 21, 22, 23

LIBRARY section ...........................12
Library Window ............................17
LINK button (6.1 only) ................24
Long channel names ... 19, 20, 21, 23

M
Master fader .....................................7
MASTER page ...............................27
Master Window ...............................7
Meter mode ...................................27
Meter Window ..............................27
Meters .........................................7, 26
MIX BALANCE control ...............26
MUTE GROUP buttons

........................ 13, 14, 15, 16
MUTE GROUP section

........................ 13, 14, 15, 16

O
Offline ..............................................7
Offline Edit .................................. 4, 7
ON button ................. 7, 9, 10, 11, 14
ONLINE/OFFLINE button ............7
OPEN button .................................17
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Opening a previously saved Session
............................................ 4

OUT button ................................... 25
Output channels ............................ 10
Output Patch Library .................... 17
OUTPUT PATCH LINK .............. 18
Output patch page ........................ 20

P
Pair icon ............................. 13, 14, 15
PAN CONTROL ............................. 7
PAN control .................................... 9
PAN section ................................... 13
Pan/Aux Send display ..................... 9
Paste ................................................. 6
Patch editor window ..................... 19
Patchbay ............................. 19, 20, 23
PC -> Console ............................. 3, 4
PEAK HOLD button .................... 27
PHASE button ................................. 8
Port names ................... 19, 20, 21, 23
POSITION parameter .................. 27
PROTECT ...................................... 18
PROTECT button ......................... 18

R
RECALL button ............................ 18
Redo ................................................. 5
Remote Channels .......................... 11
Remote target name ...................... 11
Resynchronizing DM1000 Editor .. 4
ROUTING buttons ......................... 8
ROUTING section ........................ 13

S
SAVE AS button ............................ 18
SAVE button .................................. 18
Saving the current Session .............. 4
Saving the current Session with a 

new name .......................... 4
Scene number display ..................... 7
SELECT button ............... 7, 9, 10, 11
Selected Channel Window ........... 12
Short channel name .................. 9, 10
Shortcuts, keyboard ...................... 28
SOLO button ............................. 9, 10
SOURCE parameter ........................ 8
STEREO button ........................ 8, 10
Stereo Out ...................................... 16
Stereo page ..................................... 27
STORE button ............................... 18
Surround editor window .............. 24

Surround mode parameter .......... 24
Surround pan graph ..................... 24
Surround pan position ................. 24
Synchronization .............................. 4
Synchronize ..................................... 4
Synchronizing DM1000 Editor ..... 4
System Setup ................................... 2

T
Timecode counter window .......... 25
TITLE ............................................. 18
TO STEREO section ..................... 14
Total Recall ...................................... 4

U
Undo ................................................ 5
UNDO button ............................... 18
User Assignable Layer ................... 11
User Defined ................................. 11

V
View menu ...................................... 8

W
wet signal ....................................... 26
Window

Layer ........................................... 8
Library ..................................... 17
Master ........................................ 7
Meter ........................................ 27
Patch editor ............................. 19
Selected Channel ..................... 12
Surround editor ...................... 24
Timecode counter ................... 25

window ............................................ 7
Window Control from Console .... 3
WindowEffect editor .................... 25

Y
Y56K card ........................................ 4
Yamaha Web Site ............................ 1
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